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Form Prompts Translation Utility 

The Form Prompts utility program enables you to translate labels for AppsRules 
fields, check boxes, and buttons from the default English to other languages. If you 
have installed patch 655FRM05, you can also translate menu items and tab labels. 
You can translate into any language installed for use on Oracle Applications. 
To use the program, you would identify the “internal” form, block, and field names 
of each item you want to translate, one per row in a grid called Form Display Prompts. 
You would then select the language into which you are translating and provide a trans-
lated version of the field, check box, button label, menu item, or tab label. 
You can use Oracle Help features to identify the internal form, block, and field names 
of items you want to translate, then type those names into fields on the Form Display 
Prompts grid. Alternatively, you can run the Event Tracker, a feature of LogicalApps 
AppsForm, to “capture” the internal names of fields and check boxes, and then select 
them on the Form Display Prompts grid. The Event Tracker does not capture internal 
names for buttons, menus, or tabs. However, values for all items (fields, check boxes, 
buttons, menu options, and tabs) are given in this document (beginning on page 6), so 
that these values can be entered manually. 

Determining Internal Form, Block, and Field Names 
To discover the internal name for a LogicalApps form, complete these steps: 
1 Navigate to the form whose internal name you want to know. 
2 Select Help in the menu bar, and then About Oracle Applications in the Help menu. 
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3 An About Oracle Applications window opens. In it, scroll to the Current Form 
section and take note of the Form Name. For example, LAAACCESS is the form 
name for the AppsAccess Define Conflict Rules form: 

 
4 Click on the OK button to close the form. 
To discover the internal block and field names for fields and check boxes, you can 
complete the following steps. (Or, for these items as well as buttons, menus, and tabs, 
you can consult the sections of this document beginning on page 6.) 
1 Click on (or tab to) an item whose block and field names you want to know.  
2 Select Help in the menu bar, then Diagnostics in the Help menu, then Examine 

in the Diagnostics submenu. 
3 An Enable Diagnostics dialog prompts for the Oracle password. Enter the pass-

word for your instance and click on the OK button. 
4 An Examine Field and Variable Values form opens. Note the internal block and 

field names for your selection. In this example, the internal names for the Conflict 
Rule Name field are LAAA_CONFLICT_ENTITIES and CONFLICT_NAME. 

 
5 Click on the OK button to close the form. 
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Using the Event Tracker 
To use the Event Tracker to “capture” internal block and field names, create a rule 
in AppsForm. A typical AppsForm rule consists of “elements,” each of which targets 
a form, block, or field and specifies an event that triggers processing. Each element 
then defines customizations to the target form, block, or field. In this case, however, 
the rule exists only to enable you to run the Event Tracker, which is one of the events 
an element can specify. So the rule will consist of one element for each AppsRules 
form, but it won’t define any customizations. 

To run the Event Tracker: 

1 Start AppsForm: Select the LogicalApps AppsRules responsibility in the Oracle 
Applications list. A LogicalApps — AppsRules form appears. In it, ensure that 
the AppsForm panel is active (this is the default selection). 

 
2 Type a name for the rule in the Rule Name field. 

3 In the Description field, briefly explain the purpose of the rule. 

4 Ensure that the Active check box is selected. 

Once the rule itself is named and described, you can create rule elements, one per 
row in the Rule Elements grid: 

1 In the Seq field, type a number. 

2 In the Element Name field, type a name for the element. 

3 Specify the form that is the target of the element: 

• In the Form Name field, select the internal name for the form (see page 1). 
AppsForm then supplies a corresponding value in the User Form Name field. 
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• In the User Form Name field, select the “user friendly,” external name for the 
form. AppsForm then supplies a corresponding value in the Form Name field. 

4 In the Event list of values, select the value Event Tracker.  
5 Repeat steps 1–4 for all forms on which you expect to translate field or check 

box labels. 

6 Save the rule: click on File in the menu bar, then on Save in the file menu. 

7 Refresh the AppsRules cache: One way is to close AppsForm. Another is to click 
on Tools in the menu bar and AppsRules Configuration in the Tools menu. An 
AppsRules Configuration window opens; in it, click on the Refresh Cache button. 

Once the elements are configured and the rule is saved, open each AppsRules appli-
cation containing forms you chose. Navigate to each form and, in it, navigate to each 
field or check box you want to translate. Create or update a record and save your 
work. By doing so, you capture a reference to each item you touch, and these items 
become available in the Form Display Prompts grid of the Form Prompts utility. 

Using the Form Prompts Utility 
To translate AppsRules field, check box, and button labels: 

1 In the Navigator for the LogicalApps responsibility, select LogicalApps Form 
Prompts. The Form Display Prompts grid opens. In this grid, devote one row to 
each item for which you are translating a screen label. 

 
2 In the Form Name list of values, enter the internal name of the form on which 

you intend to translate an item. You can type this value directly or select it from 
the list of values (even if you have not run the Event Tracker). Note that this LOV 
lists all Oracle Applications forms, not only those for AppsRules. Thus you can 
use the Form Prompts utility to translate labels in AppsRules and in other appli-
cations as well. 
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3 In the Block Name list of values, enter the internal name of the block that con-
tains the item you intend to translate. You can type this value directly or, if you 
have run the Event Tracker, select it from the list of values.  

4 Enter the internal name for the item whose label you are translating: Use the Field 
Name field for a field, check box, or button, the Tab Name field for a tab, or the 
Menu Item Name field for a menu item. You can type this value or, if the item is 
a field or check box and you have run the Event Tracker, select it from the LOV. 

5 In the Language list of values, select the language into which you are translating. 
You can type or select only a language you have installed for use on Oracle Ap-
plications. 

6 In the Display Prompt field, type your translation for the field, check box, button, 
tab, or menu item you have selected. 

7 Repeat steps 2–6 for all of the AppsRules (or other application) labels you want 
to translate. 

8 Save your work: Click on File in the menu bar, and then Save in the File menu. 

Once you have created rows of translation values, you can search among them: 

1 With the Form Display Prompts grid open, click on the flashlight icon in the 
Oracle toolbar, or View in the menu bar and Find in the View menu. The follow-
ing Find Form Prompts dialog appears: 

 
2 Specify search criteria by entering complementary values in the three fields: 

• Optionally, select an application in the Application list of values to restrict 
forms available in the form name fields to those belonging to the application 
you select. 

• Select either a user form name in the User Form Name field or an internal 
form name in the Form Name field. If you select a user form name, the Find 
form supplies its internal name automatically. If you select an internal name, 
the Find form ignores any value in the User Form Name field. 

3 Click on the Find button. The search returns entries for the form you’ve selected 
in the Form Name field. 

Alternatively, click on the Find button without specifying a form to populate the 
Form Display Prompts grid with all configured entries. Click on the New button to 
create a new row in the grid. Click on the Clear button to clear values in the three 
fields of the Find form. 
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AppsAccess 
The following illustrations, and their corresponding lists, identify the internal form, 
block, and field names for fields, check boxes, buttons, and tabs in AppsAccess.  

Find Conflict Rules 
For the Find Conflict Rules form, the internal form name is LAAACCESS, and the 
block name is CONFLICT_FIND. Field names are shown below. 

 
1 CONFLICT_NAME 

2 ENTITY_TYPE 

3 APPLICATION_NAME 

4 ENTITY_NAME 

5 NOTIFY_ROLE 

6 APPROVAL_GROUP 

7 END_DATED_CONFLITS 

8 FIND_CONFLICTS_EXIST_ONLY 

9 OU_YN 

10 SOB_YN 

11 APPROVAL_CRTL 

12 PREVENT_CTRL 

13 RULES_CTRL 

14 ACCESS_FIND_NEW 

15 ACCESS_FIND_CLEAR 

16 ACCESS_FIND 
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Define Conflict Rules/User Conflict Approval 
For the Define Conflict Rules and User Conflict Approval forms, the internal form 
name is LAAACCESS.  

 
1 Block: LAAA_CONFLICT_ENTITIES  

Field: CONFLICT_NAME 

2 Block: LAAA_CONFLICT_ENTITIES  
Field: ENTITY_TYPE 

3 Block: LAAA_CONFLICT_ENTITIES  
Field: APPLICATION_NAME 

4 Block: LAAA_CONFLICT_ENTITIES  
Field: ENTITY_NAME 

5 Block: LAAA_CONFLICT_ENTITIES  
Field: CONFLICT_APPLICATION_NAME 

6 Block: LAAA_CONFLICT_ENTITIES  
Field: CONFLIT_ENTITY_NAME 

7 Block: LAAA_CONFLICT_ENTITIES  
Field: CONFLITS_EXIST 

8 Block: LAAA_CONFLICT_ENTITIES  
Field: ACTION_TYPE 

9 Block: LAAA_CONFLICT_ENTITIES  
Field: OU_YN 

10 Block: LAAA_CONFLICT_ENTITIES  
Field: SOB_YM 

11 Block: LAAA_CONFLICT_ENTITIES  
Field: NOTIFICATION_TO_DEXC 
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12 Block: LAAA_CONFLICT_ENTITIES  
Field: APPROVAL_GROUP 

13 Block: LAAA_CONFLICT_ENTITIES  
Field: START_DATE 

14 Block: LAAA_CONFLICT_ENTITIES  
Field: END_DATE 

15 Block: LAAA_CONFLICT_ENTITIES  
Field: REASON 

16 Block: ACCESS_CONTROL  
Field: CREATE_SNAPSHOT 

17 Block: ACCESS_CONTROL  
Field: LAUNCH_MASS_UPDATE 

18 Block: ACCESS_CONTROL  
Field: VIEW_CONFLICTS 

19 Block: ACCESS_CONTROL  
Field: ACCESS_RULES 

20 Block: ACCESS_CONTROL  
Field: GLOBAL_SUBSCRIBERS 

User Conflicts 
For the User Conflicts form, the internal form name is LAAACCESS. 

 
1 Block: LAAA_CONFLICT_ENTITIES 

Field: CONFLICT_NAME_MIRROR 

2 Block: LAAA_CONFLICT_ENTITIES 
Field: ENTITY_TYPE_MIRROR 

3 Block: LAAA_CONFLICT_ENTITIES 
Field: APPLICATION_NAME_MIRROR 
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4 Block: LAAA_CONFLICT_ENTITIES 
Field: ENTITY_NAME_MIRROR 

5 Block: LAAA_CONFLICT_ENTITIES 
Field: CONFLICT_APPLICATION_MIRROR 

6 Block: LAAA_CONFLICT_ENTITIES 
Field: CONFLICT_ENTITY_NAME_MIRROR 

7 Block: LAA_USER_CONFLICT_ENTITIES_U_V 
Field: RUN_DATE 

8 Block: LAA_USER_CONFLICT_ENTITIES_U_V 
Field: USER_NAME 

9 Block: LAA_USER_CONFLICT_ENTITIES_U_V 
Field: RESPONSIBILITY_NAME 

10 Block: LAA_USER_CONFLICT_ENTITIES_U_V  
Field: CONFLICT_RESPONSIBILITY_NAME 

11 Block: LAA_USER_CONFLICT_ENTITIES_U_V 
Field: STATUS 

12 Block: ACCESS_CONTROL 
Field: REFRESH_USER_CONFLICT 

13 Block: ACCESS_CONTROL 
Field: VIEW_APPROVALS 

User Conflict Actions 
For the User Conflict Actions form, the internal form name is LAAACCESS. 

 
1 Block: LAA_USER_CONFLICT_ACTIONS_V 

Field: CONFLIT_USER 

2 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: CONFLICT_NAME 

3 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: ACTION_USER 
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4 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: APPROVAL_TYPE 

5 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: START_DATE 

6 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: END_DATE 

7 Block: LAA_USER_CONFLICT_ACTIONS_V 
Field: COMMENTS 

8 Block: ACCESS_CONTROL 
Field: ACTION_DONE 

Mass Update User Conflicts 
For the Mass Update User Conflicts form, the internal form name is LAAACCESS. 

 
1 Block: LAA_MASS_UPDATE_FIND 

Field: USER_NAME 

2 Block: LAA_MASS_UPDATE_FIND 
Field: CONFLICT_NAME 

3 Block: LAA_MASS_UPDATE_FIND 
Field: APPLICATION_NAME 

4 Block: LAA_MASS_UPDATE_FIND 
Field: CONFLIT_APPLICATION_NAME 

5 Block: LAA_MASS_UPDATE_FIND 
Field: RESPONSIBILITY_NAME 

6 Block: LAA_MASS_UPDATE_FIND 
Field: CONFLICT_RESPONSIBILITY_NAME 
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7 Block: LAA_MASS_UPDATE_FIND 
Field: RUN_DATE 

8 Block: LAA_MASS_UPDATE_FIND 
Field: ORDER_BY_YN 

9 Block: LAA_MASS_UPDATE_FIND 
Field: FIND 

10 Block: ACCESS_CONTROL 
Field: REFRESH_MASS_UPDATE 

11 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: USER_NAME 

12 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: CONFLICT_NAME 

13 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: RESPONSIBILITY_NAME 

14 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: CONFLICT_RESPONSIBILITY_NAME 

15 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: APPROVE 

16 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: REJECT 

17 Block: LAA_MASS_UPDATE_DETAILS 
Field: APPLICATION_NAME 

18 Block: LAA_MASS_UPDATE_DETAILS 
Field: CONFLIT_APPLICATION_NAME 

19 Block: LAA_MASS_UPDATE_DETAILS 
Field: ENTITY_NAME 

20 Block: LAA_MASS_UPDATE_DETAILS 
Field: CONFLICT_ENTITY_NAME 

21 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: SELECT_ALL_APPR 

22 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: DESELECT_ALL_APPR 

23 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: SELECT_ALL_REJECT 

24 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: DESELECT_ALL_REJECT 

25 Block: LAA_MASS_UPDATE_USER_CONFLICTS 
Field: ACTION 

26 Block: ACCESS_CONTROL 
Field: DONE 
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Mass Update Action 
for the Mass Update Action form, the internal form name is LAAACCESS. 

 
1 Block: LAA_MASS_UPDATE_ACTION 

Field: COMMENT 
2 Block: LAA_MASS_UPDATE_ACTION 

Field: OK 
3 Block: LAA_MASS_UPDATE_ACTION 

Field: CANCEL 

Global Subscribers 
There are four global-subscriber forms, one for each type of subscriber. All four are 
shown below, with annotations that show their internal block and field values. For all 
four, the internal form name is LAAXCLNS. 

 
1 Block: None 

Tab: INCL_EXCL_OU 

2 Block: LAA_INCLUDE_OU_V 
Field: OU_NAME 

3 Block: LAA_INCLUDE_OU_V 
Field: ACTIVE_FLAG 

4 Block: LAA_EXCLUDE_OU_V 
Field: OU_NAME 

5 Block: LAA_EXCLUDE_OU_V 
Field: ACTIVE_FLAG 
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1 Block: None 

Tab: EXCLUDE_FNC_MENU 

2 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: MENU_NAME 

3 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: USER_MENU_NAME 

4 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: SUB_MENU_NAME 

5 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: USER_SUB_MENU_NAME 

6 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: FUNCTION_NAME (not shown in illustration) 

7 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: USER_FUNCTION_NAME (not shown in illustration) 

8 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: DESCRIPTION (not shown in illustration) 

9 Block: LAA_EXCLUDE_FNC_MENU_V 
Field: ACTIVE_FLAG (not shown in illustration) 

 
1 Block: None 

Tab: EXCLUDE_DATA_GRP 



Form Prompts Translation Utility 

14 AppsRules  

2 Block: LAA_EXCLUDE_DATA_GRP_V 
Field: DATA_GROUP_NAME 

3 Block: LAA_EXCLUDE_DATA_GRP_V 
Field: DESCRIPTION 

4 Block: LAA_EXCLUDE_DATA_GRP_V 
Field: ACTIVE_FLAG 

 
1 Block: None 

Tab: EXCLUDE_USER 

2 Block: LAA_USER_EXCLUSIONS_V 
Field: USER_NAME 

3 Block: LAA_USER_EXCLUSIONS_V 
Field: DESCRIPTION 

4 Block: LAA_USER_EXCLUSIONS_V 
Field: ACTIVE_FLAG 

Activate Responsibilities 
For the Activate Responsibilities form, the internal form name is LAASCAUS. 

 
1 Block: USER 

Field: USER_NAME 
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2 Block: USER 
Field: DESCRIPTION 

3 Block: USER_RESP 
Field: RESPONSIBILITY_NAME 

4 Block: USER_RESP 
Field: APPLICATION_NAME 

5 Block: USER_RESP 
Field: SECURITY_GROUP_NAME 

6 Block: USER_RESP 
Field: START_DATE 

7 Block: USER_RESP 
Field: END_DATE 

8 Block: CONTROL 
Field: ICA 

9 Block: CONTROL 
Field: CANCEL 

Initiate Analysis 
For the Activate Responsibilities form, the internal form name is LAASCAUS. 

 
1 Block: USER_CONFLICT_ANALYSIS 

Field: RESPONSIBILITY_NAME 

2 Block: USER_CONFLICT_ANALYSIS 
Field: CONFLICT_RESPONSIBILITY_NAME 

3 Block: USER_CONFLICT_ANALYSIS 
Field: CONFLICT_NAME 

4 Block: USER_CONFLICT_ANALYSIS 
Field: CONTROL_TYPE 

5 Block: USER_CONFLICT_ANALYSIS 
Field: ACTION_TYPE_DESC 

6 Block: USER_CONFLIT_ANALYSIS 
Field: CANCEL 
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7 Block: USER_CONFLIT_ANALYSIS 
Field: SUBMIT 

8 Block: USER_CONFLICT_ANALYSIS 
Field: FUNCTION_NAME (not shown in illustration) 

9 Block: USER_CONFLICT_ANALYSIS 
Field: CONFLICT_FUNCTION_NAME (not shown in illustration) 

10 Block: USER_CONFLICT_ANALYSIS 
Field: SAME_OU_YN (not shown in illustration) 

11 Block: USER_CONFLICT_ANALYSIS 
Field: SAME_SOB_YN (not shown in illustration) 

AppsAccess Menus 
For AppsAccess, the Tools menu offers the following two options:  

Display Prompt Form Name Menu Item Name 

Where Used LAAACCESS Where Used 

Conflict Where Used LAAACCESS Conflict Where Used 

AppsControl 
The following illustrations, and their corresponding lists, identify the internal form, 
block, and field names for fields, check boxes, buttons, and tabs in AppsControl. 

AppsControl Find 
For the AppsControl Find form, the internal form name is LACHGWIZ, and the block 
name is LAAD_QUERY_FIND_BLOCK. Field names are shown below. 

 
1 APPLICATION_NAME 
2 USER_FORM_NAME 
3 FORM_NAME 
4 BLOCK_NAME 
5 CLEAR 
6 NEW 
7 FIND 
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AppsControl Wizard — Change Element/Change Details 
The AppsControl Wizard has several tabs, each of which reveals a distinct panel. The 
first of the next four figures identifies the tabs, fields, and buttons available when one 
opens the Wizard. Each remaining figure shows items available when a tab is selected 
(but does not repeat items shown here). The internal form name is LACHGWIZ. 

 
1 Block: None 

Tab: CHANGE_ELEMENT 

2 Block: None 
Tab: TRANSLATIONS 

3 Block: LA_CC_ELEMENT_HEADERS 
Field: CHANGE_FORM_NAME 

4 Block: LA_CC_ELEMENT_HEADERS 
Field: USER_FORM_NAME 

5 Block: LA_CC_ELEMENT_HEADERS 
Field: APPLICATION_NAME 

6 Block: LA_CC_ELEMENT_HEADERS 
Field: CHANGE_BLOCK_NAME 

7 Block: LA_CC_ELEMENT_HEADERS 
Field: CHECK_WNR_WVR 

8 Block: None 
Tab: CHANGE_DETAILS 

9 Block: None 
Tab: COLUMN_TRANSLATIONS 
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10 Block: None 
Tab: RULES 

11 Block: LA_CC_ELEMENT_LINES 
Field: CHANGE_FIELD_NAME 

12 Block: LA_CC_ELEMENT_LINES 
Field: USER_FIELD_NAME 

13 Block: LA_CC_ELEMENT_LINES 
Field: CHANGE_TYPE 

14 Block: LA_CC_ELEMENT_LINES 
Field: NOTIFICATION_ROLE 

15 Block: LA_CC_ELEMENT_LINES 
Field: REASON_CODE 

16 Block: LA_CC_ELEMENT_LINES 
Field: ENABLED_FLAG 

17 Block: LA_CC_ELEMENT_LINES 
Field: REASON 

18 Block: CONTROL 
Field: GENERATE_RULE 

19 Block: CONTROL 
Field: GENERATESELECTEDRULES 

AppsControl Wizard — Change Element/Column Translations 
The internal form name remains LACHGWIZ. 
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1 Block: LA_CC_ELEMENT_LINES 
Field: CHANGE_ELEMENT_MIR2 

2 Block: LA_CC_ELEMENT_LINES 
Field: CHANGE_COLUMN_NAME 

AppsControl Wizard — Change Element/Rules 
The internal form name remains LACHGWIZ. 

 
1 Block: LA_CC_ELEMENT_LINES 

Field: CHANGE_ELEMENT_MIR 

2 Block: LA_CC_ELEMENT_LINES 
Field: RULE_NAME 

3 Block: LA_ CC_ELEMENT_LINES 
Field: PROCESS_NAME 

4 Block: LA_CC_ELEMENT_LINES 
Field: AUDIT_TABLE 

5 Block: LA_CC_ELEMENT_LINES 
Field: SELECTRULEGENCHK 
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AppsControl Wizard — Translations 
The internal form name remains LACHGWIZ. 

 
1 Block: LA_CC_ELEMENT_HEADERS 

Field: PROMPT1 
2 Block: LA_CC_ELEMENT_HEADERS 

Field: FIELD1 
3 Block: LA_CC_ELEMENT_ HEADERS 

Field: TABLE_NAME 
4 Block: CONTROL 

Field: IMPORT 
5 Block: LA_CC_PRIMARY_KEYS 

Field: PK_COLUMN 
6 Block: LA_CC_PRIMARY_KEYS 

Field: FORM_FIELD 

Reason Code 
For the Reason Code form, the internal form name is LACHGWIZ. 

 
1 Block: LA_CC_REASON_TYPE 

Field: LOOKUP_TYPE 
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2 Block: LA_CC_REASON_TYPE 
Field: LOOKUP_DESCRIPTION 

3 Block: LA_CC_REASON_LOOKUPS 
Field: LOOKUP_REASON_CODE 

4 Block: LA_CC_REASON_LOOKUPS 
Field: LOOKUP_REASON_DESCRIPTION 

5 Block: LA_CC_REASON_LOOKUPS 
Field: ENABLED_FLAG 

Change Request 
For the Change Request form, the internal form name is LACHGREASON. 

 
1 Block: LA_CC_REASON_HEADERS 

Field: REASON_IDENTIFIER1 
2 Block: LA_CC_REASON_LINES 

Field: USER_FIELD_NAME 
3 Block: LA_CC_REASON_LINES 

Field: ORIGINAL_VALUE 
4 Block: LA_CC_REASON_LINES 

Field: NEW_VALUE 
5 Block: LA_CC_REASON_LINES 

Field: REASON_CODE 
6 Block: LA_CC_REASON_LINES 

Field: CREATION_DATE 
7 Block: LA_CC_REASON_LINES 

Field: CREATED_BY_MIR 
8 Block: LA_CC_REASON_LINES 

Field: APPROVE_STATUS 
9 Block: LA_CC_REASON_LINES 

Field: REASON_DESCRIPTION 
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10 Block: LA_CC_REASON_LINES 
Field: DONE 

11 Block: LA_CC_REASON_LINES 
Field: CANCEL 

12 Block: LA_CC_REASON_LINES 
Field: REJECT 

AppsControl Menus 
For AppsControl, the Tools menu offers the following three options:  

Display Prompt Form Name Menu Item Name 

AppsControl Reason Code LACHGWIZ AppsControl Reason Code 

AppsAudit Compile Audit 
Objects 

LACHGWIZ AppsAudit Compile Audit 
Objects 

AppsForm Refresh Cache LACHGWIZ AppsForm Refresh Cache 

AppsForm 
The following illustrations, and their corresponding lists, identify the internal form, 
block, and field names for fields, check boxes, buttons, and tabs in AppsForm. 

Main Form 
When you start AppsRules, it opens to the following AppsForm home form. Its 
internal form name is LABIZ.  
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1 Block: None 
Tab: APPS_RULES 

2 Block: LA_BR_RULES 
Field: NAME 

3 Block: LA_BR_RULES 
Field: DESCRIPTION 

4 Block: LA_BR_RULES 
Field: DEBUG_FLAG 

5 Block: LA_BR_RULES 
Field: ENABLED_FLAG 

6 Block: LA_BR_RULES 
Field: SUBSCRIBERS_EXIST 

7 Block: LA_BR_RULE_ELEMENTS 
Field: ELEMENT_ORDER 

8 Block: LA_BR_RULE_ELEMENTS 
Field: DESCRIPTION 

9 Block: LA_BR_RULE_ELEMENTS 
Field: FORM_NAME 

10 Block: LA_BR_RULE_ELEMENTS 
Field: USER_FORM_NAME 

11 Block: LA_BR_RULE_ELEMENTS 
Field: USER_TRIGGERING_EVENT 

12 Block: LA_BR_RULE_ELEMENTS 
Field: BLOCK_NAME 

13 Block: LA_BR_RULE_ELEMENTS 
Field: FIELD_NAME 

14 Block: LA_BR_RULE_ELEMENTS 
Field: DEBUG_FLAG 

15 Block: LA_BR_RULE_ELEMENTS 
Field: ENABLED_FLAG 

16 Block: LA_BR_RULE_ELEMENTS 
Field: LONG_DESCRIPTION 

17 Block: CONTROL 
Field: HEADER_SUBSCRIBERS 

18 Block: CONTROL 
Field: ELEMENT_SUBSCRIBERS 

19 Block: CONTROL 
Field: DETAILS_BUTTON 
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Subscribers  
For the Subscribers form, the internal form name is LABIZ. 

 
1 Block: LA_BR_SUBSCRIBERS 

Field: FILTER_TYPE 

2 Block: LA_BR_SUBSCRIBERS 
Field: PROFILE 

3 Block: LA_BR_SUBSCRIBERS 
Field: FILTER_CONDITION 

4 Block: LA_BR_SUBSCRIBERS 
Field: FILTER_VALUE_MIR 

5 Block: LA_BR_SUBSCRIBERS 
Field: DATA_VALUE_TYPE 

6 Block: LA_BR_SUBSCRIBERS 
Field: DATA_VALUE_FIELD_TYPE 

7 Block: LA_BR_SUBSCRIBERS 
Field: DATA_VALUE 

8 Block: LA_BR_SUBSCRIBERS 
Field: AND_OR_CONDITION 

9 Block: LA_BR_SUBSCRIBERS 
Field: GROUP_NUM 

10 Block: LA_BR_SUBSCRIBERS 
Field: REVERSAL_FLAG 

11 Block: CONTROL 
Field: SUBSCRIBERS_VIEW_WHERE 

12 Block: CONTROL 
Field: SUBSCRIBERS_DONE 
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Subscribers Where Statement 
For the Subscribers Where Statement form, the internal form name is LABIZ, and the 
block name is CONTROL. The field names appear below. 

 
1 WHERE_STATEMENT 

2 WHERE_STATEMENT_DONE 

Subscriber Lists 
For the Subscribers Lists form, the internal form name is LABIZ. 

 
1 Block: LA_BR_SUBSCRIBER_LISTS 

Field: SUBACRIBER_NAME 
2 Block: LA_BR_SUBSCRIBER_LISTS 

Field: DESCRIPTION 
3 Block: LA_BR_SUBSCRIBER_LISTS 

Field: START_DATE 
4 Block: LA_BR_SUBSCRIBER_LISTS 

Field: END_DATE 
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5 Block: LA_BR_SUBSCRIBER_ELEMENTS 
Field: AND_OR_CONDITION 

6 Block: LA_BR_SUBSCRIBER_ELEMENTS 
Field: FILTER_TYPE 

7 Block: LA_BR_SUBSCRIBER_ ELEMENTS 
Field: PROFILE 

8 Block: LA_BR_SUBSCRIBER_ ELEMENTS 
Field: FILTER_CONDITION 

9 Block: LA_BR_SUBSCRIBER_ ELEMENTS 
Field: FILTER_VALUE_MIR 

10 Block: LA_BR_SUBSCRIBER_ ELEMENTS 
Field: GROUP_NUM 

11 Block: CONTROL 
Field: SUBSCRIBER_LISTS_WHERE 

12 Block: CONTROL 
Field: SUBSCRIBER_LIST_DONE 

Business Rule Details — Security 
The Business Rule Details form has several tabs, each of which reveals a distinct 
panel. The following illustration identifies a set of five fields that appear at the top of 
the form, and a button that appears at the bottom no matter what tab is selected; it 
also shows items available when a Security tab is selected. Subsequent illustrations 
identify items that are available when other tabs are selected (but do not re-identify 
the constant fields and button). The internal form name is LABIZ.  

 
1 Block: LA_BR_RULE_ELEMENTS 

Field: FORM_NAME_MIR 
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2 Block: LA_BR_RULE_ELEMENTS 
Field: DESCRIPTION_MIR 

3 Block: LA_BR_RULE_ELEMENTS 
Field: TRIGGERING_EVENT_DISP 

4 Block: LA_BR_RULE_ELEMENTS 
Field: BLOCK_NAME_MIR 

5 Block: LA_BR_RULE_ELEMENTS 
Field: FIELD_NAME_MIR 

6 Block: None 
Tab: SECURITY 

7 Block: LA_BR_SECURITY 
Field: ENTITY_TYPE 

8 Block: LA_BR_SECURITY 
Field: BLOCK_NAME 

9 Block: LA_BR_SECURITY 
Field: FIELD_NAME 

10 Block: LA_BR_SECURITY 
Field: CASE_RESTRICTION 

11 Block: LA_BR_SECURITY 
Field: REQUIRED_FLAG 

12 Block: LA_BR_SECURITY 
Field: NO_UPDATE_FLAG 

13 Block: LA_BR_SECURITY 
Field: NO_INSERT_FLAG 

14 Block: LA_BR_SECURITY 
Field: NO_DELETE_FLAG 

15 Block: LA_BR_SECURITY 
Field: NO_DISPLAY_FLAG 

16 Block: LA_BR_SECURITY 
Field: ENABLED_FLAG 

17 Block: LA_BR_SECURITY 
Field: DEFAULT_WHERE 

18 Block: LA_BR_SECURITY 
Field: ORDER_BY 

19 Block: CONTROL 
Field: DETAILS_DONE 
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Business Rule Details — Navigation 
For each tab on the Business Rule Details form, the internal form name remains LABIZ.  

 
1 Block: None 

Tab: NAVIGATION 
2 Block: LA_BR_MENUS 

Field: SEQUENCE_NUM 
3 Block: LA_BR_MENUS 

Field: LABEL 
4 Block: LA_BR_MENUS 

Field: USER_FUNCTION_NAME 
5 Block: LA_BR_MENUS 

Field: PARAMETERS 
6 Block: LA_BR_MENUS 

Field: ICON_NAME 
7 Block: LA_BR_MENUS 

Field: RULE_ACTION 
8 Block: LA_BR_MENUS 

Field: MENU_DISABLE 
9 Block: LA_BR_MENUS 

Field: ENABLED_FLAG 
10 Block: LA_BR_ZOOMS 

Field: FROM_BLOCK 
11 Block: LA_BR_ ZOOMS 

Field: TO_USER_FUNCTION 
12 Block: LA_BR_ ZOOMS 

Field: PARAMETERS 
13 Block: LA_BR_ ZOOMS 

Field: ENABLES_FLAG 
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Business Rule Details — Messages 
For each tab on the Business Rule Details form, the internal form name remains LABIZ.  

 
1 Block: None 

Tab: MESSAGES 
2 Block: LA_BR_MESSAGES 

Field: SEQUENCE_NUM 
3 Block: LA_BR_MESSAGES 

Field: DESCRIPTION 
4 Block: LA_BR_MESSAGES 

Field: MESSAGE_TYPE 
5 Block: LA_BR_MESSAGES 

Field: ENABLED_FLAG 
6 Block: LA_BR_MESSAGES 

Field: MESSAGE_TEXT 

Business Rule Details — Default Values 
For each tab on the Business Rule Details form, the internal form name remains LABIZ.  
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1 Block: None 
Tab: DEFAULT_VALUES 

2 Block: LA_BR_DEFAULT_VALUES 
Field: BLOCK_NAME 

3 Block: LA_BR_DEFAULT_VALUES 
Field: FIELD_NAME 

4 Block: LA_BR_DEFAULT_VALUES 
Field: VALUE_TYPE 

5 Block: LA_BR_DEFAULT_VALUES 
Field: DEFAULT_VALUE 

6 Block: LA_BR_DEFAULT_VALUES 
Field: ENABLED_FLAG 

Business Rule Details — List of Values 
For each tab on the Business Rule Details form, the internal form name remains LABIZ.  

 
1 Block: None 

Tab: LIST_OF_VALUES 

2 Block: LA_BR_LOV_CHANGES 
Field: BLOCK_NAME 

3 Block: LA_BR_LOV_CHANGES 
Field: FIELD_NAME 

4 Block: LA_BR_LOV_CHANGES 
Field: RECORD_GROUP 
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5 Block: LA_BR_LOV_CHANGES 
Field: LOV_NAME 

6 Block: LA_BR_LOV_CHANGES 
Field: ENABLED_FLAG 

7 Block: LA_BR_LOV_CHANGES 
Field: SQL_TEXT 

Business Rule Details — Field Attributes 
For each tab on the Business Rule Details form, the internal form name remains 
LABIZ.  

 
1 Block: None 

Field: FIELD_ATTRIBUTES 

2 Block: LA_BR_FIELD_ATTRIBUTES 
Field: SEQUENCE 

3 Block: LA_BR_FIELD_ATTRIBUTES 
Field: ENTITY_TYPE 

4 Block: LA_BR_FIELD_ATTRIBUTES 
Field: BLOCK_NAME 

5 Block: LA_BR_FIELD_ATTRIBUTES 
Field: FIELD_NAME 

6 Block: LA_BR_FIELD_ATTRIBUTES 
Field: COLOR_PROPERTY_MIR 
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7 Block: LA_BR_FIELD_ATTRIBUTES 
Field: VALUE 

8 Block: LA_BR_FIELD_ATTRIBUTES 
Field: ENABLED_FLAG 

Business Rule Details — SQL 
For each tab on the Business Rule Details form, the internal form name remains 
LABIZ.  

 
1 Block: None 

Field: SQL 

2 Block: LA_BR_SQL_RULES 
Field: SEQUENCE_NUM 

3 Block: LA_BR_SQL_RULES 
Field: PROCEDURE_NAME 

4 Block: LA_BR_SQL_RULES 
Field: ENABLED_FLAG 

5 Block: LA_BR_SQL_RULES 
Field: SQL_TEXT 

6 Block: CONTROL 
Field: SQL_COMPILE 
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Business Rule Details — AppsFlow 
For each tab on the Business Rule Details form, the internal form name remains 
LABIZ.  

 
1 Block: None 

Tab: APPSFLOW 

2 Block: LA_BR_FLOWS 
Field: SEQUENCE 

3 Block: LA_BR_FLOWS 
Field: PROCESS_NAME 

4 Block: LA_BR_FLOWS 
Field: DISPOSITION_TYPE 

5 Block: LA_BR_FLOWS 
Field: DISPOSITION_ID1 

6 Block: LA_BR_FLOWS 
Field: DISPOSITION_ID2 

7 Block: LA_BR_FLOWS 
Field: ACTIVE_FLAG 
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Form Elements 
The Form Elements form is accessible from the Tools menu when the Security tab is 
selected in the Business Rule Details form. The internal form name is LABIZ. 

 
1 Block: LA_BR_FORM_ELEMENTS 

Field: BLOCK_NAME 

2 Block: LA_BR_FORM_ELEMENTS 
Field: PROMPT_TEXT 

3 Block: LA_BR_FORM_ELEMENTS 
Field: FIELD_NAME 

4 Block: LA_BR_FORM_ELEMENTS 
Field: ITEM_TYPE 

5 Block: LA_BR_FORM_ELEMENTS 
Field: ITEM_CANVAS 

6 Block: LA_BR_FORM_ELEMENTS 
Field: ITEM_TABBED_CANVAS_PAGE 

7 Block: LA_BR_FORM_ELEMENTS 
Field: INCLUDE_FLAG 

8 Block: CONTROL 
Field: SECURITY_SELECT_ALL 

9 Block: CONTROL 
Field: SECURITY_ACCEPT 

10 Block: CONTROL 
Field: FORM_ELEMENTS_CLOSE 

11 Block: CONTROL 
Field: SECURITY_UNSELECT_ALL 
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AppsExtend 
The AppsExtend form is available from the Tools menu. Its internal form name is 
LAAPEN.  

 
1 Block: LA_FORM_EXTENSIONS 

Field: EXTENSION_NAME 

2 Block: LA_FORM_EXTENSIONS 
Field: DESCRIPTION 

3 Block: LA_EXTENSION_ELEMENTS 
Field: ATTRIBUITE 

4 Block: LA_EXTENSION_ELEMENTS 
Field: ATTRIBUTE_LABEL 

5 Block: LA_EXTENSION_ELEMENTS 
Field: ENABLED_FLAG 

6 Block: LA_EXTENSION_ELEMENTS 
Field: REQUIRED_FLAG 

7 Block: LA_EXTENSION_ELEMENTS 
Field: ENABLE_LOV 
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Add Custom Events 
The AppsExtend form is available from the Tools menu. Its internal form name is 
LABIZ. 

 
1 Block: LA_BR_CUSTOM_EVENTS 

Field: USER_FORM_NAME 

2 Block: LA_BR_CUSTOM_EVENTS 
Field: FORM_NAME 

3 Block: LA_BR_CUSTOM_EVENTS 
Field: EVENT_NAME 

4 Block: LA_BR_CUSTOM_EVENTS 
Field: INSERT 

AppsForm Menus 
For AppsForm, the Tools menu offers the following options:  

Display Prompt Form Name Menu Item Name 

AppsRules Configurations LABIZ AppsRules Configurations 

AppsRules Subscriber Lists LABIZ AppsRules Subscriber Lists 

AppsRules Form Elements LABIZ AppsRules Form Elements 

AppsRules Define Multiple Keys LABIZ AppsRules Define Multiple Keys 

AppsRules Compile All Active SQL 
Rules 

LABIZ AppsRules Compile All Active SQL 
Rules 

AppsExtend LABIZ AppsExtend 

Add Custom Events LABIZ Add Custom Events 

The LogicalApps Utilities menu also offers menu options for selection, but because 
these are available as well from AppsForm and AppsAudit, they are documented sep-
arately (on page 74).  
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AppsFlow 
The following illustrations, and their corresponding lists, identify the internal form, 
block, and field names for fields, check boxes, buttons, and tabs in AppsFlow. 

Main Form — Process Rule Details 
When you open AppsRules and click on the AppsFlow tab, the following home 
form opens. From it you can open four panels (as shown in the following four illus-
trations). The internal form name is LABIZ.  

 
1 Block: None 

Tab: APPS_FLOW 
2 Block: None 

Tab: PROCESS 
3 Block: LAAF_PROCESSES 

Field: PROCESS_NAME 
4 Block: LAAF_PROCESSES 

Field: PROCESS_TYPE 
5 Block: LAAF_PROCESSES 

Field: PROCESS_STATUS 
6 Block: LAAF_PROCESSES 

Field: PROCESS_OWNER_DISP 
7 Block: LAAF_PROCESSES 

Field: DESCRIPTION 
8 Block: AF_CONTROL 

Field: SUBSCRIPTIONS 
9 Block: AF_CONTROL 

Field: PROCESS_FLOWS 
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Main Form — Primary Keys 
For each tab on the main form, the internal form name remains LABIZ. 

 
1 Block: None 

Tab: DISPOSITIONS 
2 Block: LAAF_PROCESSES 

Field: PROCESS_NAME_PR 
3 Block: LAAF_PROCESSES 

Field: TABLE_NAME 
4 Block: LAAF_PROCESSES 

Field: QUERY_COL1 
5 Block: LAAF_ PROCESSES 

Field: QUERY_COL2 

Main Form — Display Table/View Columns 
For each tab on the main form, the internal form name remains LABIZ. 
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1 Block: None 
Tab: DISPLAY_COLUMNS 

2 Block: LAAF_PROCESSES 
Field: PROCESS_NAME_DIS 

3 Block: LAAF_PROCESSES 
Field: DISPLAY_VIEW 

4 Block: LAAF_PROCESSES 
Field: DISPLAY_COL1 

5 Block: LAAF_PROCESSES 
Field: DISPLAY_COL_TITLE1 

6 Block: LAAF_PROCESSES 
Field: DISPLAY_COL2 

7 Block: LAAF_PROCESSES 
Field: DISPLAY_COL_TITLE2 

Main Form — Effectivity Dates 
For each tab on the main form, the internal form name remains LABIZ. 

 
1 Block: None 

Tab: DATES 

2 Block: LAAF_PROCESSES 
Field: PROCESS_NAME_DATE 

3 Block: LAAF_PROCESSES 
Field: START_DATE_ACTIVE 

4 Block: LAAF_PROCESSES 
Field: END_DATE_ACTIVE 
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Launch Flow Criteria 
For the Launch Flow Criteria form, the internal form name is LABIZ.  

 
1 Block: LAAF_PROCESS_SUBSCRIPTIONS 

Field: SEQUENCE 

2 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: DESCRIPTION 

3 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: SUBSCRIPTION_TYPE 

4 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: ACTIVE_FLAG 

5 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: TABLE_NAME 

6 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: PRIMARY_KEY1 

7 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: PRIMARY_KEY2 

8 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: INSERT_FLAG 

9 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: UPDATE_FLAG 

10 Block: AF_CONTROL 
Field: TRIGGER_COMPILE 
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11 Block: LA_TRIGGER_COLUMNS 
Field: COLUMN_NAME 

12 Block: LA_TRIGGER_COLUMNS 
Field: CONDITION 

13 Block: LA_TRIGGER_COLUMNS 
Field: COLUMN_VALUE 

14 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: SCHEDULE_FREQUENCY 

15 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: FREQUENCY 

16 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: SCHEDULE_START_DATE 

17 Block: LAAF_PROCESS_SUBSCRIPTIONS 
Field: SCHEDULE_END_DATE 

AppsFlow Process Flows — Constraints 
When a user selects the Process Flows button from the main AppsFlow form, the 
following form appears. The top portion of it remains constant; the bottom portion 
changes according to the rule type you select (in field 3 of the following illustration). 
The first illustration in the following series shows the entire form; each of the re-
maining eight shows the bottom portion of the form for one of the rule types (with 
the understaing that the top portion remains as it is shown here). 
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1 Block: LAAF_PROCESS_FLOWS 
Field: SEQUENCE 

2 Block: LAAF_PROCESS_FLOWS 
Field: CODE 

3 Block: LAAF_PROCESS_FLOWS 
Field: FLOW_TYPE 

4 Block: LAAF_PROCESS_FLOWS 
Field: FUNCTIONAL_OWNER_DISP 

5 Block: LAAF_PROCESS_FLOWS 
Field: FUNCTIONAL_OWNER_DYNAMIC_DISP 

6 Block: LAAF_PROCESS_FLOWS 
Field: TIME_OUT_TYPE 

7 Block: LAAF_PROCESS_FLOWS 
Field: TIME_OUT_VALUE 

8 Block: LAAF_PROCESS_FLOWS 
Field: INCLUDE_WEEKENDS 

9 Block: LAAF_PROCESS_FLOWS 
Field: ACTIVE_FLAG 

10 Block: LAAF_PROCESS_FLOWS 
Field: DESCRIPTION 

11 Block: LAAF_PROCESS_FLOWS 
Field: NOTIFICATION_TEXT 

12 Block: None 
Tab: CONSTRAINTS 

13 Block: LAAF_CONSTRAINTS 
Field: SEQUENCE 

14 Block: LAAF_CONSTRAINTS 
Field: CONSTRAINT_NAME 

15 Block: LAAF_CONSTRAINTS 
Field: DESCRIPTION 

16 Block: LAAF_CONSTRAINTS 
Field: OVERRIDE_ALLOWED 

17 Block: LAAF_CONSTRAINTS 
Field: ACTIVE_FLAG 

18 Block: LAAF_CONSTRAINTS 
Field: NOTIFICATION_TEXT 
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AppsFlow Process Flows — Concurrent Programs 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ.  

 
1 Block: None 

Tab: PROGRAMS 

2 Block: LAAF_CONC_REQUESTS 
Field: SEQUENCE 

3 Block: LAAF_CONC_REQUESTS 
Field: USER_NAME_DISP 

4 Block: LAAF_CONC_REQUESTS 
Field: RESPONSIBILITY_NAME_DISP 

5 Block: LAAF_CONC_REQUESTS 
Field: CONCURRENT_PROGRAM_NAME 

6 Block: LAAF_CONC_REQUESTS 
Field: PARAMETERS 

7 Block: LAAF_CONC_REQUESTS 
Field: MULTIORG 

8 Block: LAAF_CONC_REQUESTS 
Field: DESCRIPTION 

9 Block: LAAF_CONC_REQUESTS 
Field: WAIT_FOR_FLOW 

10 Block: LAAF_CONC_REQUESTS 
Field: ACTIVE_FLAG 

11 Block: LAAF_CONC_REQUESTS 
Field: RUNTIME_PARAMS 
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When a users selects the M. Org check box, a new tab provides access to the follow-
ing panel: 

 
1 Block: None 

Tab: AF_PROGRAM_MO 

2 Block: LAAF_CONC_REQUEST_MULTIORG 
Field: USER_NAME_DISP 

3 Block: LAAF_CONC_REQUEST_MULTIORG 
Field: RESPONSIBILITY_NAME_DISP 

4 Block: LAAF_CONC_REQUEST_MULTIORG 
Field: PARAMETERS 

When a user selects the Runtime Parameters/Completion Options button, the fol-
lowing form appears: 
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1 Block: LAAF_CONC_REQUESTS 
Field: NOTIFY_ROLE_DISP 

2 Block: LAAF_CONC_REQUESTS 
Field: COMPLETE_NORMAL 

3 Block: LAAF_CONC_REQUESTS 
Field: COMPLETE_ERROR 

4 Block: LAAF_CONC_REQUESTS 
Field: COMPLETE_WARNING 

5 Block: LAAF_CONC_REQUESTS 
Field: PRINTER_NAME 

6 Block: LAAF_CONC_REQUESTS 
Field: NUMBER_OF_COPIES 

7 Block: LAAF_RUNTIME_PARAMS 
Field: PROMPT 

8 Block: LAAF_ RUNTIME_PARAMS 
Field: PARAM_TYPE 

9 Block: LAAF_ RUNTIME_PARAMS 
Field: PARAM_VALUE 

AppsFlow Process Flows — Approvals 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ. 

 
1 Block: None 

Tab: APPROVALS 

2 Block: LAAF_PROCESS_FLOWS 
Field: RUNTIME_TIME_OUT_HOURS_DISP 

3 Block: LAAF_PROCESS_FLOWS 
Field: APPROVAL_GROUP_MIR 
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4 Block: LAAF_PROCESS_FLOWS 
Field: APPROVAL_GROUP_DYNAMIC_MIR 

5 Block: LAAF_PROCESS_FLOWS 
Field: NOTIFICATION_FUNCTION 

6 Block: LAAF_PROCESS_FLOWS 
Field: DOCUMENT_LINK 

7 Block: LAAF_PROCESS_FLOWS 
Field: NOTIFICATION_BODY_MIR 

8 Block: LAAF_PROCESS_FLOWS 
Field: REJECT_SQL_DISP 

9 Block: LAAF_PROCESS_FLOWS 
Field: TIMEOUT_SQL_DISP 

10 Block: LAAF_PROCESS_FLOWS 
Field: NUMBER_OF_RESUBMITS 

AppsFlow Process Flows — Exceptions 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ. 

 
1 Block: None 

Tab: EXCEPTIONS 

2 Block: LAAF_INTERFACES 
Field: SEQUENCE 

3 Block: LAAF_INTERFACES 
Field: INTERFACE_NAME 

4 Block: LAAF_INTERFACES 
Field: RESUBMISSION_PROGRAM_DISP 
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5 Block: LAAF_INTERFACES 
Field: WAIT_TYPE 

6 Block: LAAF_INTERFACES 
Field: WAIT_TIME 

7 Block: LAAF_INTERFACES 
Field: NEEDS_TO_BE_CLEAR 

8 Block: LAAF_INTERFACES 
Field: ACTIVE_FLAG 

9 Block: LAAF_INTERFACES 
Field: NOTIFICATION_TEXT 

AppsFlow Process Flows — SQL 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ. 

 
1 Block: None 

Tab: AF_SQL 

2 Block: LAAF_SQL_DETAILS 
Field: SEQUENCE 

3 Block: LAAF_SQL_DETAILS 
Field: SQL_NAME 

4 Block: LAAF_SQL_DETAILS 
Field: DESCRIPTION 

5 Block: LAAF_SQL_DETAILS 
Field: ACTIVE_FLAG 
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AppsFlow Process Flows — Processes 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ. 

 
1 Block: None 

Tab: PROCESSES 

2 Block: LAAF_LINKED_PROCESSES 
Field: SEQUENCE 

3 Block: LAAF_LINKED_PROCESSES 
Field: CALLED_PROCESS_DISP 

4 Block: LAAF_LINKED_PROCESSES 
Field: LINKED_PROCESS_DESC_DISP 

5 Block: LAAF_LINKED_PROCESSES 
Field: WAIT_FOR_FLOW 

6 Block: LAAF_LINKED_PROCESSES 
Field: ACTIVE_FLAG 

AppsFlow Process Flows — Workflow/Event 
For each rule type that can be selected in the Process Flows form, the internal form 
name remains LABIZ. 
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1 Block: None 
Tab: WORKFLOW 

2 Block: AF_WORKFLOW 
Field: WORKFLOW_SEQ 

3 Block: AF_WORKFLOW 
Field: WORKFLOW_TYPE 

4 Block: AF_WORKFLOW 
Field: WORKFLOW_ITEM_TYPE 

5 Block: AF_WORKFLOW 
Field: WORKFLOW_PROCESS_NAME 

6 Block: AF_WORKFLOW 
Field: WAIT_FOR_FLOW 

7 Block: AF_WORKFLOW 
Field: ACTIVE_FLAG 

8 Block: AF_ATTRIBUTES 
Field: ATTRIBUTE_NAME 

9 Block: AF_ATTRIBUTES 
Field: ATTRIBUTE_TYPE 

10 Block: AF_ATTRIBUTES 
Field: ATTRIBUTE_VALUE 

AppsFlow Process Flows — Conditions 
From any of the panels specific to a rule type, the user can also select a Conditions 
panel. The internal form name remains LABIZ. 

 
1 Block: None 

Field: CONDITIONS 

2 Block: LAAF_CONDITIONS 
Field: SEQUENCE 
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3 Block: LAAF_CONDITIONS 
Field: CONDITION 

4 Block: LAAF_CONDITIONS 
Field: DESCRIPTION 

5 Block: LAAF_CONDITIONS 
Field: ACTIVE_FLAG 

Advanced Rules Wizard — Definition 
When a user selects the Advanced Rules Wizard option on the LogicalApps Utilities 
menu, the following form appears. Its content depends upon the rule type the user 
selects. Three fields near the top are constant; the fourth, Constraint Type, appears 
only if the rule type is Constraint/Condition; and all four fields are identified only in 
the following illustration. The form may display up to four tabs, each of which offers 
a selection of fields, and each of the following four illustrations identifes fields acces-
ible from one of the tabs. The internal form name is LAAFCONST.  

 
1 Block: LAAF_CONSTRAINT_DEFINITIONS 

Field: CONSTRAINT_NAME 

2 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: CONSTRAINT_TYPE 

3 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: DESCRIPTION 

4 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: ERROR_IF_EXISTS 
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5 Block: None 
Tab: DEFINITIONS 

6 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: TABLE_NAME 

7 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: DISPOSITION_ID1 

8 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: TABLE_ALIAS 

9 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: DISPOSITION_ID2 

10 Block: LAAF_RELATED_ENTITIES 
Field: ENTITY_NAME 

11 Block: LAAF_RELATED_ENTITIES 
Field: TABLE_ALIAS 

12 Block: LAAF_RELATED_ENTITIES 
Field: DESCRIPTION 

13 Block: LAAF_RELATED_COLUMNS 
Field: TABLE_NAME_W 

14 Block: LAAF_RELATED_ COLUMNS 
Field: TABLE_ALIAS 

15 Block: LAAF_RELATED_ COLUMNS 
Field: COLUMN_NAME_W 

16 Block: LAAF_RELATED_ COLUMNS 
Field: TABLE_NAME_W2 

17 Block: LAAF_RELATED_ COLUMNS 
Field: TABLE_ALIAS2 

18 Block: LAAF_RELATED_ COLUMNS 
Field: COLUMN_W2 

19 Block: LAAF_CONSTRAINT_COLUMNS 
Field: GROUP_NUMBER 

20 Block: LAAF_CONSTRAINT_COLUMNS 
Field: TABLE_NAME 

21 Block: LAAF_CONSTRAINT_COLUMNS 
Field: TABLE_ALIAS 

22 Block: LAAF_CONSTRAINT_COLUMNS 
Field: COLUMN_NAME 

23 Block: LAAF_CONSTRAINT_COLUMNS 
Field: CONDITION 
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24 Block: LAAF_CONSTRAINT_COLUMNS 
Field: ENTITY_TYPE 

25 Block: LAAF_CONSTRAINT_COLUMNS 
Field: VALUE 

26 Block: LAAF_CONSTRAINT_COLUMNS 
Field: AND_OR 

Advanced Rules Wizard — Return Columns 
For any of the panels that can be selected in the Advanced Rules Wizard, the internal 
form name is LAAFCONST.   

 
1 Block: None 

Tab: INTERFACE_COLUMNS 

2 Block: LAAF_INTERFACE_COLUMNS 
Field: SEQUENCE 

3 Block: LAAF_INTERFACE_COLUMNS 
Field: TABLE_NAME 

4 Block: LAAF_INTERFACE_COLUMNS 
Field: TABLE_ALIAS 

5 Block: LAAF_INTERFACE_COLUMNS 
Field: COLUMN_NAME 

6 Block: LAAF_INTERFACE_COLUMNS 
Field: TITLE 
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7 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: LAUNCH_PROCESS_NAME 

8 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: LAUNCH_DISPOSITION_ID1 

9 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: LAUNCH_DISPOSITION_ID2 

Advanced Rules Wizard — SQL 
For any of the panels that can be selected in the Advanced Rules Wizard, the internal 
form name is LAAFCONST.   

 
1 Block: None 

Tab: SQL 

2 Block: LAAF_CONSTRAINT_DEFINITIONS 
Field: CONSTRAINT_SQL 

3 Block: CONTROL 
Field: SQL 

4 Block: CONTROL 
Field: VERIFY_SQL 
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Advanced Rules Wizard — Notification 
For any of the panels that can be selected in the Advanced Rules Wizard, the internal 
form name is LAAFCONST.   

 
1 Block: None 

Tab: NOTIFICATION 
2 Block: LAAF_CONSTRAINT_DEFINITIONS  

Field: NOTIFICATION_SUBJECT 
3 Block: LAAF_CONSTRAINT_DEFINITIONS 

Field: NOTIFICATION_HEADER 
4 Block: LAAF_CONSTRAINT_DEFINITIONS 

Field: NOTIFICATION_BODY 
5 Block: LAAF_CONSTRAINT_DEFINITIONS 

Field: STANDARD_NOTIFICATION 
6 Block: LAAF_ COLUMNS 

Field: TABLE_ALIAS  
7 Block: NOTIFICATION_COLUMNS 

Field: COLUMN_NAME 
8 Block: NOTIFICATION_COLUMNS 

Field: ADD_TO_SUBJECT 
9 Block: NOTIFICATION_COLUMNS 

Field: ADD_TO_HEADER 
10 Block: LAAF_CONSTRAINT_DEFINITIONS 

Field: ADD_TO_BODY 
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AppsFlow Configurations 
When a user selects the AppsFlow Configuration option on the AppsFlow menu, the 
following form appears. The internal name for the form is LABIZ.  

 
1 Block: LAAF_CONFIGURATIONS 

Field: DEBUG_FLAG 

2 Block: LAAF_CONFIGURATIONS 
Field: PURGE_DEBUG_DAYS 

3 Block: LAAF_CONFIGURATIONS 
Field: FORM_REVISION 

4 Block: AF_CONTROL 
Field: CONFIGURATIONS_DONE 

AppsFlow Debug  
When the debug options are enabled in the previous form, the following form pre-
sents debug data. To open the form, a user selects the AppsFlow Debug Data option 
in the AppsFlow menu. The internal form name is LABIZ.  

 
1 Block: LAAF_DEBUG_TABLE 

Field: ITEMTYPE 

2 Block: LAAF_DEBUG_TABLE 
Field: ITEMKEY 

3 Block: LAAF_DEBUG_TABLE 
Field: CREATION_DATE 
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4 Block: LAAF_DEBUG_TABLE 
Field: PROCEDURE_NAME_MIR 

5 Block: LAAF_DEBUG_TABLE 
Field: DEBUG_MSG 

6 Block: LAAF_DEBUG_TABLE 
Field: DEBUG_OR_ERROR 

7 Block: AF_CONTROL 
Field: RESET_DEBUG 

8 Block: AF_CONTROL 
Field: DEBUG_DONE 

AppsFlow Approval Roles 
When a user selects the AppsFlow Define Roles option on the AppsFlow menu, the 
following form appears. The internal name for the form is LABIZ.  

 
1 Block: WF_LOCAL_ROLES 

Field: NAME 

2 Block: WF_LOCAL_ROLES 
Field: DESCRIPTIONS 

3 Block: WF_LOCAL_ROLES 
Field: DISPLAY_NAME 

4 Block: WF_LOCAL_ROLES 
Field: STATUS 

5 Block: WF_LOCAL_ROLES 
Field: NOTIFICATION_PREFERENCE 
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6 Block: WF_LOCAL_ROLES 
Field: EXPIRATION_DATE 

7 Block: WF_LOCAL_USER_ROLES 
Field: USER 

8 Block: AF_CONTROL 
Field: ROLES_DONE 

AppsFlow Approval Groups 
When a user selects the AppsFlow Define Approval Groups option on the AppsFlow 
menu, the following form appears. The internal name for the form is LABIZ.  

 
1 Block: LAAF_APP 

Field: APPROVAL_GROUP 

2 Block: LAAF_APP 
Field: DESCRIPTION 

3 Block: LAAF_APP 
Field: START_DATE_ACTIVE 

4 Block: LAAF_APP 
Field: END_DATE_ACTIVE 

5 Block: LAAF1_APP_ROLES 
Field: SEQUENCE 

6 Block: LAAF1_APP_ROLES 
Field: ROLE_DISP 

7 Block: LAAF1_APP_ROLES 
Field: DESCRIPTION 

8 Block: LAAF1_APP_ROLES 
Field: VOTE_PERCENT 

9 Block: LAAF1_APP_ROLES 
Field: APPROVAL_TYPE 
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10 Block: LAAF1_APP_ROLES 
Field: START_DATE_ACTIVE 

11 Block: LAAF1_APP_ROLES 
Field: END_DATE_ACTIVE 

12 Block: AF_CONTROL 
Field: APPROVALS_DONE 

AppsFlow Launch Workflow Process 
When a user selects the AppsFlow Launch Flow option on the AppsFlow menu, the 
following form appears. The internal name for the form is LABIZ. 

 
1 Block: AF_CONTROL 

Field: DISPOSITION_ID1 
2 Block: AF_CONTROL 

Field: DISPOSITION_ID2 
3 Block: AF_CONTROL 

Field: LAUNCH_PROCESS 
4 Block: AF_CONTROL 

Field: LAUNCH_PROCESS_CANCEL 

AppsFlow Export Workflow 
When a user selects the AppsFlow Export to Workflow option on the AppsFlow 
menu, the following form appears. The internal name for the form is LABIZ. 

 
1 Block: AF_CONTROL 

Field: EXPORT_PROCESS_NAME 
2 Block: AF_CONTROL 

Field: EXPORT_PROCESS 
3 Block: AF_CONTROL 

Field: CANCEL_PROCESS 
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AppsFlow Menus 
For AppsFlow, the AppsFlow menu offers the following options: 

Display Prompt Form Name Menu Item Name 

AppsFlow Configurations LABIZ AppsFlow Configurations 

AppsFlow Define Roles LABIZ AppsFlow Define Roles 

AppsFlow Define Approval Groups LABIZ AppsFlow Define Approval Groups 

AppsFlow Debug Data LABIZ AppsFlow Debug Data 

AppsFlow Launch Flow LABIZ AppsFlow Launch Flow 

AppsFlow Launch Background 
Program 

LABIZ AppsFlow Launch Background 
Program 

AppsFlow Monitor Conc Programs LABIZ AppsFlow Monitor Conc Programs 

AppsFlow Export to Workflow LABIZ AppsFlow Export to Workflow 

The LogicalApps Utilities menu also offers menu options for selection, but because 
these are available as well from AppsForm and AppsAudit, they are documented sep-
arately (on page 74).  

AppsAudit 
The following illustrations, and their corresponding lists, identify the internal form, 
block, and field names for fields, check boxes, buttons, and tabs in AppsAudit.  

Audit Groups 
When you open AppsRules and click on the AppsAudit tab, the following form 
opens. The internal form name is LABIZ. 

 
1 Block: None 

Tab: APPS_AUDIT 
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2 Block: None 
Tab: AUDIT_GROUPS 

3 Block: LAAD_AUDIT_GROUPS 
Field: APPLICATION_NAME 

4 Block: LAAD_AUDIT_GROUPS 
Field: RESP_BUTTON 

5 Block: LAAD_AUDIT_GROUPS 
Field: GROUP_NAME 

6 Block: LAAD_AUDIT_GROUPS 
Field: STATE 

7 Block: LAAD_AUDIT_GROUPS 
Field: DESCRIPTION 

8 Block: LAAD1_AUDIT_TABLES_V 
Field: TABLE_NAME 

9 Block: LAAD1_AUDIT_TABLES_V 
Field: APPLICATION 

10 Block: LAAD1_AUDIT_TABLES_V 
Field: DESCRIPTION 

11 Block: LAAD1_AUDIT_TABLES_V 
Field: SCHEMA1 

12 Block: LAAD1_AUDIT_TABLES_V 
Field: AUDIT_ENABLED 

Audit Group Responsibilities 
When a user clicks on the Responsibility Security button in the Audit Groups form, 
the following form appears. Its internal name is LABIZ.  

 
1 Block: LAAD_VAL_RESP 

Field: RESP_NAME 

2 Block: LAAD_VAL_RESP 
Field: OK 
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Audit Columns 
When a user clicks on the Audit Columns tab, the following form appears. Its inter-
nal name is LABIZ.  

 
1 Block: None 

Tab: AUDIT_COLUMNS 

2 Block: LAAD1_AUDIT_TABLES_V 
Field: AUDIT_TABLE_NAME 

3 Block: LAAD_AUDIT_GROUPS 
Field: AUDIT_GROUP_NAME 

4 Block: LAAD1_AUDIT_TABLES_V 
Field: IMPORT_COLUMNS 

5 Block: LAAD_COLUMNS_V 
Field: COLUMN_NAME 

6 Block: LAAD_COLUMNS_V 
Field: USER_COLUMN_NAME 

7 Block: LAAD_COLUMNS_V 
Field: PKEY 

8 Block: LAAD_COLUMNS_V 
Field: REPORTING_KEY 

9 Block: LAAD_COLUMNS_V 
Field: LC_TRANSLATION_TYPE 

10 Block: LAAD_COLUMNS_V 
Field: LC_TABLE_NAME 
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11 Block: LAAD_COLUMNS_V 
Field: LC_TRANSLATION_COLUMN 

12 Block: LAAD_TRANSLATION_COLUMNS 
Field: TRANSLATION_COLUMN_NAME 

13 Block: LAAD_TRANSLATION_COLUMNS 
Field: TRANSLATION_COLUMN_TYPE 

14 Block: LAAD_TRANSLATION_COLUMNS 
Field: COLUMN_NAME 

Import Columns 
When a user clicks on the Import Columns button in the Audit Columns form, the 
following form appears. Its internal name is LABIZ.  

 
1 Block: LAAD_AUDIT_COLUMNS 

Field: COLUMN_NAME 

2 Block: LAAD_AUDIT_COLUMNS 
Field: DESCRIPTION 

3 Block: LAAD_AUDIT_COLUMNS 
Field: INCLUDE_FLAG 

4 Block: LAAD_AUDIT_COLUMNS 
Field: AUDIT_COLUMNS_SELECT_ALL 

5 Block: LAAD_AUDIT_COLUMNS 
Field: AUDIT_COLUMNS_UNSELECT_ALL 

6 Block: LAAD_AUDIT_COLUMNS 
Field: LAAD_AUDIT_COLUMNS_ACCEPT 

7 Block: LAAD_AUDIT_COLUMNS 
Field: LAAD_AUDIT_COLUMNS_CLOSE 
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Audit Report 
When a user selects the AppsAudit Report option from the LogicalApps Utilities 
menu, the following form appears. Its internal name is LAAPPSAUDITREPORT.  

 
1 Block: None 

Tab: AUDIT_REPORT 

2 Block: LAAD_REP_SUB_HEADERS 
Field: REPORT_NAME 

3 Block: LAAD_REP_SUB_HEADERS 
Field: GROUP_NAME 

4 Block: LAAD_REP_SUB_HEADERS 
Field: TABLE_NAME 

5 Block: LAAD_REP_SUB_HEADERS 
Field: START_DATE 

6 Block: LAAD_REP_SUB_HEADERS 
Field: END_DATE 

7 Block: LAAD_REP_SUB_HEADERS 
Field: NUM_DAYS 

8 Block: LAAD_REP_SUB_HEADERS 
Field: USERNAME 

9 Block: LAAD_REP_SUB_HEADERS 
Field: REPORT_STYLE 

10 Block: LAAD_REP_SUB_HEADERS 
Field: DEBUG_LEVEL 

11 Block: LAAD_REP_SUB_HEADERS 
Field: REFRESH 
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12 Block: LAAD_REP_SUB_HEADERS 
Field: DISPLAY_IDS 

13 Block: LAAD1_REP_SUB_DETAILS 
Field: TABLE_NAME 

14 Block: LAAD1_REP_SUB_DETAILS 
Field: COLUMN_NAME 

15 Block: LAAD1_REP_SUB_DETAILS 
Field: USER_COLUMN_NAME 

16 Block: LAAD1_REP_SUB_DETAILS 
Field: INCLUDE_FOR_REPORT 

17 Block: LAAD1_REP_SUB_DETAILS 
Field: COLUMN_TYPE 

18 Block: LAAD1_REP_SUB_DETAILS 
Field: OLD_VALUE_FROM 

19 Block: LAAD1_REP_SUB_DETAILS 
Field: OLD_VALUE_TO 

20 Block: LAAD1_REP_SUB_DETAILS 
Field: NEW_VALUE_FROM 

21 Block: LAAD1_REP_SUB_DETAILS 
Field: NEW_VALUE_TO 

22 Block: LAAD1_REP_SUB_DETAILS 
Field: DETAILS_SELECT_ALL 

23 Block: LAAD1_REP_SUB_DETAILS 
Field: DETAILS_UNSELECT_ALL 

24 Block: LAAD_REP_SUB_HEADERS 
Field: RESUBMIT_TYPE 

25 Block: LAAD_REP_SUB_HEADERS 
Field: RESUBMIT_INTERVAL 

26 Block: LAAD_REP_SUB_HEADERS 
Field: SCHEDULED 

27 Block: LAAD_REP_SUB_HEADERS 
Field: START_DATE_SUBMIT 

28 Block: LAAD_REP_SUB_HEADERS 
Field: END_DATE_SUBMIT 

29 Block: LAAD_REP_SUB_HEADERS 
Field: REQUEST_ID 

30 Block: LAAD_REP_SUB_HEADERS 
Field: REPORT_SUBMISSION 
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AppsAudit Find 
When a user selects the Find option from the View menu while the Audit Report 
form is open, the following form appears. Its internal name is LAAPPSAUDITREPORT.  

 
1 Block: LAAD_AUDIT_FIND 

Field: REPORT_NAME 
2 Block: LAAD_AUDIT_FIND 

Field: GROUP_NAME 
3 Block: LAAD_AUDIT_FIND 

Field: TABLE_NAME 
4 Block: LAAD_AUDIT_FIND 

Field: SCHEDULED 
5 Block: LAAD_AUDIT_FIND 

Field: CLEAR 
6 Block: LAAD_AUDIT_FIND 

Field: NEW 
7 Block: LAAD_AUDIT_FIND 

Field: FIND 

AppsAudit Online 
The AppsAudit Online form is accessible from the Tools menu on an audited Oracle 
Applications form (provided that appropriate configuration has been done first). The 
internal name for the form is LAAPPSAUDITONLINE. 
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1 Block: LAAD_AUDIT_ONLINE 
Field: PRIMARY_KEY_NAME 

2 Block: LAAD_AUDIT_ONLINE 
Field: PRIMARY_KEY_VALUE 

3 Block: LAAD_AUDIT_ONLINE 
Field: AUDIT_USER_COLUMN_NAME 

4 Block: LAAD_AUDIT_ONLINE 
Field: AUDIT_COLUMN_VALUE_FIND 

5 Block: LAAD_AUDIT_ONLINE 
Field: NUM_OF_DAYS 

6 Block: LAAD_AUDIT_ONLINE 
Field: REFRESH 

7 Block: LAAD_ONLINE_AUDIT_COLUMNS 
Field: AUDIT_COLUMN_NAME 

8 Block: LAAD_ONLINE_AUDIT_COLUMNS 
Field: AUDIT_COLUMN_VALUE 

9 Block: LAAD_ONLINE_AUDIT_COLUMNS 
Field: AUDIT_TIMESTAMP 

10 Block: LAAD_ONLINE_AUDIT_COLUMNS 
Field: AUDIT_USER_NAME 

11 Block: LAAD_ONLINE_AUDIT_COLUMNS 
Field: AUDIT_TRANSACTION_TYPE 

Migration 
A Migration utility is available from AppsForm, AppsFlow, or AppsAudit. It displays 
two setup forms that are identical for the three applications, a distinct migration form 
for each application, and a single import form for all three applications. 

Migration Setup 
The first of the two migration setup forms appears when a user selects the Migration 
Setup option on the LogicalApps Utilities menu. Its internal name is LAMIG.  
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1 Block: None 
Tab: SETUP_MACHINES 

2 Block: LAAM_MACHINES 
Field: MACHINE_NAME 

3 Block: LAAM_MACHINES 
Field: DESCRIPTION 

The sedond of the two migration setup forms appears when a user selects the Setup 
Instances tab. The interrnal form name remains LAMIG. 

 
1 Block: None 

Tab: SETUP_INSTANCES 

2 Block: LAAM_DATABASE_INSTANCES 
Field: HOST_NAME 

3 Block: LAAM_DATABASE_INSTANCES 
Field: INSTANCE_NAME 

4 Block: LAAM_DATABASE_INSTANCES 
Field: PORT_NUMBER 

5 Block: LAAM_DATABASE_INSTANCES 
Field: USER_NAME 

6 Block: LAAM_DATABASE_INSTANCES 
Field: DPASSWORD 

7 Block: LAAM_DATABASE_INSTANCES 
Field: CONNECTED_STRING 
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Migrate Form Rules 
The following migration form appears when a user selects the Migrate Rules option 
from the LogicalApps Utilities menu, with AppsForm active. The internal form 
name remains LAMIG:  

 
1 Block: None 

Tab: MIGRATE_FORM_RULES 
2 Block: LAAM_MIGRATE_RULES 

Field: MIGRATION_TYPE 
3 Block: LAAM_MIGRATE_RULES 

Field: LIBRARY_DISP 
4 Block: LAAM_MIGRATE_RULES 

Field: RULE_DISP 
5 Block: LAAM_MIGRATE_RULES 

Field: RULE_ELEMENT_DISP 
6 Block: LAAM_MIGRATE_RULES 

Field: TO_INSTANCE_DISP 
7 Block: LAAM_MIGRATE_RULES 

Field: TO_INSTANCE_PASSWD 
8 Block: LAAM_MIGRATE_RULES 

Field: RENAME_TYPE 
9 Block: LAAM_MIGRATE_RULES 

Field: RENAME_VALUE 
10 Block: LAAM_MIGRATE_RULES 

Field: DEBUG_LEVEL 
11 Block: LAAM_MIGRATE_RULES 

Field: FILE_NAME 
12 Block: LAAM_MIGRATE_RULES 

Field: DIRECTORY 
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13 Block: LAAM_MIGRATE_RULES 
Field: CANCEL 

14 Block: LAAM_MIGRATE_RULES 
Field: CLEAR 

15 Block: LAAM_MIGRATE_RULES 
Field: MIGRATE 

Migrate AppsFlow Processes 
The following migration form appears when a user selects the Migrate Rules option 
from the LogicalApps Utilities menu, with AppsFlow active. The internal form name 
remains LAMIG:  

 
1 Block: None 

Tab: MIGRATE_FLOW_RULES 
2 Block: LAAM_MIGRATE_FLOWS 

Field: MIGRATION_TYPE 
3 Block: LAAM_MIGRATE_FLOWS 

Field: RULE_DISP 
4 Block: LAAM_MIGRATE_FLOWS 

Field: RULE_ELEMENT_DISP 
5 Block: LAAM_MIGRATE_FLOWS 

Field: TO_INSTANCE_DISP 
6 Block: LAAM_MIGRATE_FLOWS 

Field: TO_INSTANCE_PASSWD 
7 Block: LAAM_MIGRATE_FLOWS 

Field: RENAME_TYPE 
8 Block: LAAM_MIGRATE_FLOWS 

Field: RENAME_VALUE 
9 Block: LAAM_MIGRATE_FLOWS 

Field: DEBUG_LEVEL 
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10 Block: LAAM_MIGRATE_FLOWS 
Field: FILE_NAME 

11 Block: LAAM_MIGRATE_FLOWS 
Field: DIRECTORY 

12 Block: LAAM_MIGRATE_FLOWS 
Field: CANCEL 

13 Block: LAAM_MIGRATE_FLOWS 
Field: CLEAR 

14 Block: LAAM_MIGRATE_FLOWS 
Field: MIGRATE 

Migrate Audit Rules 
The following migration form appears when a user selects the Migrate Rules option 
from the LogicalApps Utilities menu, with AppsAudit active. The internal form name 
remains LAMIG:  

 
1 Block: None 

Tab: MIGRATE_AUDIT 
2 Block: LAAM_MIGRATE_AUDIT 

Field: MIGRATION_TYPE 
3 Block: LAAM_MIGRATE_AUDIT 

Field: RULE_DISP 
4 Block: LAAM_MIGRATE_AUDIT 

Field: RULE_ELEMENT_DISP 
5 Block: LAAM_MIGRATE_AUDIT 

Field: TO_INSTANCE_DISP 
6 Block: LAAM_MIGRATE_AUDIT 

Field: TO_INSTANCE_PASSWD 
7 Block: LAAM_MIGRATE_AUDIT 

Field: DEBUG_LEVEL 
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8 Block: LAAM_MIGRATE_AUDIT 
Field: FILE_NAME 

9 Block: LAAM_MIGRATE_AUDIT 
Field: DIRECTORY 

10 Block: LAAM_MIGRATE_AUDIT 
Field: CANCEL 

11 Block: LAAM_MIGRATE_AUDIT 
Field: CLEAR 

12 Block: LAAM_MIGRATE_AUDIT 
Field: MIGRATE 

Import from File 
The following form appears when a user selects the Import from File option from 
the LogicalApps Utilities menu, no matter which application is active. The internal 
form name remains LAMIG:  

 
1 Block: None 

Tab: IMPORT_FROM_FILE 
2 Block: LAAM_IMPORT_FROM_FILE 

Field: DIRECTORY_NAME 
3 Block: LAAM_IMPORT_FROM_FILE 

Field: FILE_NAME 
4 Block: LAAM_IMPORT_FROM_FILE 

Field: DEBUG_LEVEL 
5 Block: LAAM_IMPORT_FROM_FILE 

Field: CANCEL 
6 Block: LAAM_IMPORT_FROM_FILE 

Field: CLEAR 
7 Block: LAAM_IMPORT_FROM_FILE 

Field: IMPORT 
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Libraries 
A Libraries utility is available from AppsForm, AppsFlow, or AppsAudit. It displays 
a single form, but because some fields in the form are initially hidden (and are revealed 
through use of a scroll bar), the following figure is in three sections, to show all the 
fields. The internal form name is LABRLIBS.  

 
1 Block: LABR_LIBRARIES 

Field: LIBRARY_NAME 
2 Block: LABR_LIBRARIES 

Field: DESCRIPTION 
3 Block: LABR_LIBRARIES 

Field: VERSION 
4 Block: LABR_LIBRARIES 

Field: THEME 
5 Block: LABR_LIBRARIES 

Field: CATEGORY 
6 Block: LABR_LIBRARIES 

Field: MODULE 
7 Block: LABR1_LIBRARY_COMPONENTS 

Field: SEQUENCE 
8 Block: LABR1_LIBRARY_COMPONENTS 

Field: TYPE1 
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9 Block: LABR1_LIBRARY_COMPONENTS 
Field: RULE_NAME 

10 Block: LABR1_LIBRARY_COMPONENTS 
Field: PROCESS_FLOWS 

11 Block: LABR1_LIBRARY_COMPONENTS 
Field: APPSEXTEND_NAME 

12 Block: LABR1_LIBRARY_COMPONENTS 
Field: COMPLEXITY 

13 Block: LABR1_LIBRARY_COMPONENTS 
Field: ASSIGNED_TO 

14 Block: LABR1_LIBRARY_COMPONENTS 
Field: DEVELOPED 

15 Block: LABR1_LIBRARY_COMPONENTS 
Field: DOCUMENTED 

16 Block: LABR1_LIBRARY_COMPONENTS 
Field: TESTED 

17 Block: LABR1_LIBRARY_COMPONENTS 
Field: QA 

18 Block: LABR1_LIBRARY_COMPONENTS 
Field: COMPLETED 

19 Block: LABR1_LIBRARY_COMPONENTS 
Field: SHORT_DESCRIPTION 

Mass Associate 
A Libraries utility is available from AppsForm or AppsFlow. Its internal form name 
is LAADDFUNC.  

 
1 Block: LAADDFUNC_CTL 

Field: RESP_MENU 
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2 Block: LAADDFUNC_CTL 
Field: USER_FUNCTION_NAME 

3 Block: LA_MENU_FUNCTION 
Field: DISPLAY_NAME 

4 Block: LA_MENU_FUNCTION 
Field: ASSOCIATE_FLAG_MIR 

5 Block: LAADDFUNC 
Field: SELECT_ALL 

6 Block: LA_MENU_FUNCTION 
Field: SUBMIT 

7 Block: LA_MENU_FUNCTION 
Field: CANCEL_BUT 

LogicalApps Utilities Menu 
The LogicalApps Utilities menu contains the following options: 

Display Prompt Form Name Menu Item Name 

LogicalApps Utilities LABIZ LogicalApps Utilities 

Migration Setup LABIZ Migration Setup 

Migrate Rules LABIZ Migrate Rules 

Import from File LABIZ Import from File 

Apps Rules Libraries LABIZ Apps Rules Libraries 

Advanced Rules Wizard LABIZ Advanced Rules Wizard 

AppsAudit Create Audit Objects LABIZ AppsAudit Create Audit Objects 

AppsRules TKProf Utility LABIZ AppsRules TKProf Utility 

Mass Associate Function LABIZ Mass Associate Function 
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